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1  ORGANIZATION OF THE HW4 MANUALS 
The HW4 manuals are organized in separate books so as to limit the size of the individual documents. A list 
of the HW4 manuals is provided in document E-M-HW4v3-DIR 

 
HW4 Manuals Contents 

HW4 Main Book 

General software description 
Installation, start-up and settings 
Device connection methods 
Functions common to all devices used with HW4 

Device Specific Functions 1 
(separate book for each device type or model) 

Legacy devices (original HygroClip technology): 
 
o HygroLog NT data logger 
o HygroFlex 2, HygroFlex 3 and M3 transmitters 
o HygroLab 2 and HygroLab 3 bench indicators 
o HygroPalm 2 and HygroPalm 3 portable indicators 
o HygroClip DI digital interface 
o HygroClip Alarm programmable logic 
o HygroStat MB 
 
Device Manager (device configuration) and other device 
specific functions 

Probe Adjustment 1 Humidity and temperature adjustment function common to 
all legacy devices (original HygroClip technology) 

Device Specific Functions 2 
(separate book for each device type or model) 

Devices based on the AirChip 3000 technology: 
 
o HygroClip 2 (HC2) probes 
o HF3 transmitters and thermo-hygrostats 
o HF4 transmitters 
o HF5 transmitters 
o HF6 transmitters 
o HF7 transmitters 
o HL20 and HL21 data loggers 
o HP21, HP22 and HP23 hand-held indicators 
o Custom designed OEM products 
 
Device Manager (device configuration) and AirChip 3000 
functions 

Probe Adjustment 2 Humidity and temperature adjustment function common to 
all devices based on the AirChip 3000 technology 

Data Recording Function Data recording function common to all devices based on the 
AirChip 3000 technology 

 
Both the HW4 manuals (software) and device specific manuals (hardware) are available on the HW4 CD. 
The manuals can also be downloaded from several of the ROTRONIC web sites. 
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2  OVERVIEW 
This section of the HW4 manual covers only the HW4 functions that are unique to the HygroLog NT data 
logger. HW4 functions that are not device dependent are covered in document E-IN-HW4v3-Main. 
 

3  DEVICE MANAGER – HygroLog NT 
 

When HW4 has detected a HygroLog NT, the 
device appears in the left pane of the HW4 
main screen. Expanding the device displays a 
list of the available device functions. 
 
To select the Device Manager function, click on 
it with the left mouse button. HW4 opens the 
Device Manager form. 

 
 
 
The Device Manager form is used to configure the HygroLog NT and to read instrument specific information 
(but not the data recorded by the logger). When Device Manager is started, it automatically interrogates the 
instrument and downloads its current configuration. 
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The different forms that are available within the Device Manager form are listed in a tree located on the 
left pane of the form. To select a form, click on it with the left mouse button. 

3.1   Device Manager Menu Bar 
The Device manager menu bar is located at the top of the form. 
 
File 
 
● Open: opens the device configuration directory specified in the HW4 Settings Form - File Locations Tab 

- and displays all available device configuration files (extension .DAT). Any device configuration file that 
was previously saved can be opened to quickly configure an instrument. If so desired, any directory and 
any file type may be opened. 

 
● Save As: saves the current configuration to a file (extension .DAT) in the device configuration directory 

specified in the HW4 Settings Form - File Locations Tab. If so desired, any directory and any file type 
may be specified. 

 
● Exit: exits Device Manager 
 
Device Info 
 

 
 
This form provides additional product information that may have been entered by the factory. 
 
Help 
 
The Help menu consists of: 
 
● HW4 Help: Opens HW4 Help 
 
● About HW4: Displays the version number and ID number of HW4 
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3.2   Device Owner 
 

 
 
User information will be included in the log file when the corresponding box is checked. This is an ERES 
regulatory requirement. 
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3.3   Device Information 
 

 
 
● Device name: this text will be displayed next to the instrument model information. As far as possible 

use a unique device name. 
 
● RS485 address: click on the underlined link to change the instrument address to be used in conjunction 

with an RS-485 network (multi-drop). Each network address should be unique and within the values of 0 
to 63. Note: the default factory RS-485 address is 0. Unless necessary, do not manually modify this 
address. HW4 will automatically change the RS-485 address of the device, if so required.  

 
● Synchronize with PC clock: click on the underlined link to set the instrument date and time to match 

the PC clock. 
 
Note: the device date and time are automatically synchronized with the PC each time that the log 
function is being programmed. 

 
● Device Protection: this function is available from firmware version 1.2b. For a description, see 

document E-IN-HW4v2.1-Main 
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3.4   Language / Unit System 
 

 
 
● Language: click on the underlined link to change the language used in the device local menus and files 

to one of the available languages. The link opens the folder where the language files are located (these 
files have the extension .LNG as in English.LNG). To change the language, simply click on the 
appropriate file. 

 
● Units: use the underlined links to the right of the form to globally change the unit system used by the 

instrument. If the unit system offers several choices such as In Hg or PSI for pressure, choose a unit by 
left clicking on the arrow to the right of each text box. 
 
Humidity:  the symbol to be used after the % symbol (RH) should be typed in the text box. 
 
Note: the units selected for density per volume and density per weight also apply to vapor concentration 
and specific humidity. 

 
 
IMPORTANT: 
 
- Do not change the language / units settings while either the logger or the PC is recording data. 
 
- Make sure that the date format and separator symbols are identical to the format and separators used 

on the PC (Windows Control Panel, Regional and Language Options, Regional Options tab, Customize 
button, Time and Date tabs). Not doing so may prevent you from reading log files.  
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3.5   Memory Card 

 
 
● Log-file type: 
 
Text file (XLS): HW4 does not verify this type of file when opening the file. 
 
HW4 binary file (LOG): files of this type can be opened with HW4 but not with an editor or with Microsoft 
Excel. When opening a protected file, HW4 verifies that the file has not been tampered with. Note that 
protected binary files use less disk space than unprotected files. 
 
Select HW4 binary file to meet the ERES regulatory requirements. 
 
● Memory card full / card error alarm: 
 
Check this box to have the HygroLog NT issue an error warning when the memory card is full or has a 
problem. All versions of HW4 will show a memory card alarm condition in red on the monitor screen. HW4 
Professional can also be configured (HW4 global settings - Alarm settings tab) to display an alarm table 
and generate a report whenever any alarm or error condition issued by the HygroLog NT. 
 
● Automatically delete oldest log files: 
 
This option works only when the logger automatically closes the current log file and starts a new file 
because the current log file has reached a size limit before the logging stop time. The size of log files can 
be limited when programming the log function of the logger. For example, the logger can be programmed 
to close the current log file and to start a new one at the top of each hour, until the logging stop time has 
been reached. 
 
Enter the maximum number of full size files to be retained in the text box labeled Log-file limit. In practice, 
this number will be exceeded by one, unless all files created during the logging process happen to have 
exactly the maximum file size limit. 
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3.6   Standard Inputs 
Clicking on the plus sign to the left of “Standard Inputs” expands the tree and displays probe inputs 1 to 3. 
Inputs 1 to 3 are listed whether or not they actually exist on the logger. 
 
Only those inputs selected in the View Tab are visible in Device Manager. When the list is either empty or 
incomplete, please exit Device manager and check the selections made in the View Tab (see Right Pane: 
Device View Mode).  
 

 
 
● Input Name: use a maximum of 12 characters 
 
● Calculation: left click on the arrow to the right of the list box and select the parameter to be calculated 

by the HygroLog NT for this particular probe. This is also the calculated parameter that HW4 will display 
for this probe 
 
Dew point (Dp) or Frost point (Fp): depending on the selection made here, both the HygroLog NT and 
HW4 will display either the symbol Dp or the symbol Fp. The symbol Fp indicates that any value below 
freezing is a frost point as opposed to a dew point. When selected, the symbol Fp is also be displayed 
for values above freezing. This of course is to be understood as being the same as dew point. 

 
● Pressure: left click on the arrow to the right of the list box and select which barometric pressure will be 

used by the HygroLog NT to compute parameters such as wet-bulb, mixing ratio, etc. The HygroLog NT 
can use a fixed pressure value or use a measurement of the actual barometric pressure when an 
analog pressure probe is connected to the optional docking station. 

 
● Fixed pressure value: enter here the fixed pressure value that will be used by the HygroLog NT.  Note 

that this numerical value should be consistent with the pressure unit that was selected under Language 
/ Unit System. 

 
● Alarm: alarm conditions can be defined for humidity, temperature and the calculated parameter. Values 

that are below the low alarm value or above the high alarm value will trigger an alarm. A value can be 
specified for the alarm function hysteresis. This value is used for both the low and the high alarm. To 
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trigger an alarm only in the event that a probe is missing, disconnected or not transmitting data, simply 
enable the alarm for one of the parameters and set the Hi and Lo values to the range of the probe (for 
example 0 and 100 for humidity). All versions of HW4 will show an out-of-limits value alarm in red on the 
monitor screen. HW4 Professional can also be configured (HW4 global settings - Alarm settings tab) to 
display an alarm table and generate a report whenever an of-of-limits condition occurs. 

3.7   Display 
 

 
 
● Refresh interval: left click on the arrow to the right of the list box and select the refresh interval for the 

display of the HygroLog NT. Values range from 5 seconds to 60 minutes. To conserve battery power, 
use a high setting. 

 
● Turn the display off after: use this item enable the Display Sleep function so as to extend the battery 

lifetime. Left click with the mouse on the arrow to the right of the list box and select one of the available 
choices. The display of the HygroLog NT goes blank after the specified time period, when no key is 
being pressed or when there is no communication with the PC. 

 
● Resolution: left click on the arrow to the right of the list box and select the number of decimals to be 

used on the display of the HygroLog NT. 
 
● Display mode: left click on the arrow to the right of the list box and select the type of contents for the 

display of the HygroLog NT. Status line causes the HygroLog NT to display the date and time as well as 
which input source is providing the displayed data. 

 
● Backlight operation: left click on the arrow to the right of the list box and select between Always off, 

Always on and On key press (default). 
 
● Show trend: when this box is checked a trend indicator is displayed to the left of the measured values 

and calculated parameter. This indicator shows if the values are increasing, decreasing or stable. The 
status of each trend indicator is read directly from the HygroLog NT. 
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● Enable auto-scan of probe inputs: check this box to make the display automatically switch between 
probe inputs every 5 seconds.  

 
● Contrast: drag the slider to adjust the contrast of the display 
 
● Test the display: click on the underline link to turn on all pixels. If the LC display is good, this should 

cause the display to become uniformly black (no white areas) for a few seconds. 
 

3.8   LEDs 
 

 
 
Each of the two LEDs of the HygroLog NT can be enabled or disabled. Each LED can be tested by 
clicking on the corresponding underlined link. During the test, the LED stays on for a few seconds. 
 
The red LED can be programmed to flash when there is an out-of-limits value and / or when the logger 
requires attention (low battery, memory card full, etc.). 
 
● Alarm mode: 
 
In the non-latching mode, the red LED flashes for only as long as the data from a probe corresponds to 
an alarm condition. In the latching alarm mode, the red LED stays on even after the alarm condition has 
disappeared. When the LED is set to provide a latching alarm, it can be reset by clicking on the 
underlined link Reset the alarm. 
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3.9   Keypad 
 

 
 
To prevent tampering with the logger or to prevent changes resulting from the accidental pressing of 
keys, the keypad can be completely disabled. 
 
As an alternative, only the menu key may be disabled to protect both the logger and its probes.  
 
 
IMPORTANT: you should at least disable the MENU key to comply with FDA CFR21 Part II. 
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3.10   Sounds 
 

 
 
● Keystroke: check this box to enable a clicking feedback sound when pressing any key of the keypad. 
 
● System Error: check this box to have the HygroLog NT emit a non-repeating 5 seconds sound in the 

event of an internal error in the HygroLog NT. 
 
● Alarm: check this box to have the HygroLog NT emit a non-repeating 5 seconds sound when an alarm 

condition occurs. 
 
The pitch of the sound can be set by left clicking on the arrow located to the right of the list box and by 
selecting the desired pitch. To test the sound function, click on the underlined link. 
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3.11   Power Source 
 

 
 
● Type of internal power source: click on the arrow located to the right of the list box and choose between 

battery and accumulator (rechargeable battery). Note that trying to recharge a regular battery is 
potentially dangerous and may damage the instrument. 
 
Do not select accumulator if using a regular battery since this would allow the HygroLog NT to 
attempt recharging the battery when an external power source is connected. 
 
Note: the only way to totally power down the HygroLog NT is to disconnect the battery. 

 
● External Power Source: an external power source is automatically detected by the 

HygroLog NT 
 
● Trigger an alarm when the battery is low: see note 1 below 
 
● Trigger an alarm when there is no external power (AC power failure or disconnected / malfunctioning 

AC adapter): see note 1 below 
 
1 All versions of HW4 will show a power source alarm in red on the monitor screen. HW4 Professional can 
also be configured (HW4 global settings - Alarm settings tab) to display an alarm table and generate a 
report whenever any alarm or error condition issued by the HygroLog NT. 
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3.12   Digital Interface 
 

 
 
This form is used to select the RS-232 / RS-485 baud rate between 57600 (factory default) and 19200. 
Other data cannot be changed from within the form. Generally, leave the baud rate at 57600. Select 
19200 when you plan on connecting a mix of HygroLog NT and other devices such as the HygroFlex 
transmitter to an RS-485 multi-drop. 
 
IMPORTANT: 
 
All devices within an RS-485 multi-drop should use the same baud rate. Communication within the RS-
485 multi-drop will not work when the devices are configured with different baud rates. 
 
Docking station with wired or wireless Ethernet connection: after changing the baud rate in Device 
Manager, you should also reflect the change in the configuration of the internal Digi International module 
used by the device to connect to the LAN. See: Changing the baud rate of an Ethernet device in 
document E-IN-HW4v2.1-Main. 
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3.13   Docking Station 
 
Clicking on the plus sign to the left of “Docking Station” expands the tree and displays a list of optional 
docking station inputs (inputs 4 to 7), logical inputs and relays. These items are listed whether or not they 
actually exist on the docking station. Only those items selected in the View Tab are visible in Device 
Manager. When the list is either empty or incomplete, please exit Device manager and check the 
selections made in the View Tab (see Right Pane: Device View Mode).  Depending on the model of 
docking station the following probe types may be used: 
 
- HygroClip probe 
- RTD probe (direct 4-wire connection) 
- Analog probe 1 
- Pressure probe 1 
 
1 Must be compatible with the requirements specified in the HygroLog NT instruction manual. 

3.13.1 Probe type: HygroClip 
 
Note: this probe type selection is also used in the case of docking station DS-PT-2 (Pt100 RTD probes) - 
for more information, see Pt100 RTD probes below. 
 

 
 
● Input Name: use a maximum of 12 characters 
 
● Calculation: left click on the arrow to the right of the list box and select the parameter to be calculated 

by the HygroLog NT for this particular probe. This is also the calculated parameter that HW4 will display 
for this probe 
 
Dew point (Dp) or Frost point (Fp): depending on the selection made here, both the HygroLog NT and 
HW4 will display either the symbol Dp or the symbol Fp. The symbol Fp indicates that any value below 
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freezing is a frost point as opposed to a dew point. When selected, the symbol Fp is also be displayed 
for values above freezing. This of course is to be understood as being the same as dew point. 

 
● Pressure: left click on the arrow to the right of the list box and select which barometric pressure will be 

used by the HygroLog NT to compute parameters such as wet-bulb, mixing ratio, etc. The HygroLog NT 
can use a fixed pressure value or use a measurement of the actual barometric pressure when an 
analog pressure probe is connected to the docking station. 

 
● Fixed pressure value: enter here the fixed pressure value that will be used by the HygroLog NT.  

 
IMPORTANT: Be sure to verify that the numerical value of the fixed pressure is consistent with 
the unit system of the instrument (see Language / Unit System). Neglecting to do so may result 
in an error on the value of any parameter that uses barometric pressure as a calculation input. 

 
● Alarm: alarm conditions can be defined for humidity, temperature and the calculated parameter. Values 

that are below the low alarm value or above the high alarm value will trigger an alarm. A value can be 
specified for the alarm function hysteresis. This value is used for both the low and the high alarm. To 
trigger an alarm only in the event that a probe is missing, disconnected or not transmitting data, simply 
enable the alarm for one of the parameters and set the Hi and Lo values to the range of the probe (for 
example 0 and 100 for humidity). All versions of HW4 will show an out-of-limits value alarm in red on the 
monitor screen. HW4 Professional can also be configured (HW4 global settings - Alarm settings tab) to 
display an alarm table and generate a report whenever an out-of-limits condition occurs. 

 
Pt100 RTD probes: When using a docking station compatible with RTD probes, select HygroClip as the 
probe type. By default, temperature conditions within the range of -100 to 600°C can be measured. Enter 
a description for each Pt100 probe and set alarm values for temperature in the same way as for a 
HygroClip probe. Entries made in other fields of the form have no effect.  
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3.13.2 Probe type: Analog probe (single channel) 
 

 
 
Enter a description for the probe. Specify the range of the input voltage, the measuring range of the 
probe, the engineering unit of the parameter measured by the probe, the time required by the probe to 
warm-up, and any alarm values that you may want to use. 
 
Note: The probe inputs of docking station DS-U4-4-20 are designed for a current signal as opposed to a 
voltage signal. Each probe input uses a 150 Ohm resistor to convert 4…20 mA into 600…3000 mV 
(nominal). To compensate for tolerances on the 150 Ohm resistor, begin by entering the values 600 and 
3000 for the input voltage, and the values 4 and 20 for the measuring range. If HW4 (Current Values Tab) 
displays the value 3.90 when the input current is set to 4.00 mA, change the input voltage value 600 to 
585 (600 x 3.90 / 4.00). Proceed in a similar manner with 20 mA and 3000 mV. When done, replace the 
values 4 and 20 in the measuring range with values corresponding to the range of the physical parameter 
being measured. For example, if 4…20 mA = 0…100 PSI, enter 0 and 100 as the measuring range and 
enter the letters PSI in the unit box. 
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3.13.3 Probe type: Pressure probe 
 
The analog pressure probe is a particular case of the single channel analog probe. The difference is that 
the signal from the analog pressure probe can be used as an input by another probe input when 
calculating a psychrometric parameter that depends on the value of barometric pressure. See example 
below: 
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Enter a description for the probe. Specify the range of the input voltage, the measuring range of the 
probe, the engineering unit used for pressure, the time required by the probe to warm-up, and any alarm 
values that you may want to use. 
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3.13.4 Logical Inputs 
 
Some models of docking station feature two logical inputs that can be used to monitor external contacts 
such as may be attached to a door (see separate HygroLog NT manual). When an external contact is 
open, the corresponding logical output takes the value 0. 
 

 
 
Enter a global description for the two logical inputs and define any condition that you may want to monitor 
for the purpose of providing an alarm. 
 

3.13.5 Relay 1 / Relay 2 (docking station DS-R-1) 
 
Docking station DS-R-1 is available for use with the HygroLog NT and features two independent relay 
outputs: Relay 1 and Relay 2 (see separate HygroLog NT manual). The following form is used to program 
the function of each relay and has 3 tabs: Energize Relay, De-energize Relay and Time Schedule. To 
select any tab, click with the mouse on the tab name with the mouse. 
 
Note: when a relay is energized, the normally closed relay contact changes from closed to open and the 
normally open relay contact changes from open to closed. 
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Energize Relay Tab: 
 

 
 
Use this tab to select from the list one or several alarm conditions that will cause the relay to be 
energized. Alarm conditions for probe inputs 1 to 3 and logical inputs 1 and 2 are defined in Device 
Manager under “Input” and “Logical Inputs”. To associate an alarm condition with the relay, click on the 
corresponding check box. A check mark symbol appears. Click again on the box to remove the check 
mark and deselect the condition. 
 
If so desired, specify a time delay in seconds by typing a number in the time delay text box (use multiples 
of 5 seconds). When any of the selected conditions occurs, the relay will be energized after the time delay 
specified here, provided that the alarm condition still exists. 
 
When the relay is not energized, click with the mouse on “Click here to energize the relay (test)” to 
energize and test the relay. Note: this link is not visible when the user does not have the “Device 
configuration / log function” right. 
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De-energize Relay Tab:  
 

 
 
Use this tab to define how the relay behaves when the alarm condition(s) ends.  
 
For a latching relay action (relay remains energized after the alarm condition has ended), do not put a 
check mark in any of the boxes on the form. 
 
For a non-latching relay action, place a check mark in one of the following boxes by left clicking with the 
mouse while the mouse cursor is on top of the box: 
 
- When the alarm condition ends: the relay is automatically de-energized as soon as the alarm condition 

ends  
- Using a time delay: the relay is automatically de-energized after the specified time delay regardless of 

the status of the alarm condition that caused the relay to be energized (use multiples of 5 seconds). 
 
Note: when both boxes are check-marked, the relay is automatically de-energized depending on 
whichever condition occurs first. 
 
To de-energize the relay, click with the mouse on “click here to de-energize the relay”. The relay will not 
be energized unless a new alarm condition occurs. Note: this link is not visible when the user does not 
have the “Device configuration / log function” right. 
 
 



E-M-HW4v3-F1-001_10 Rotronic AG 
Bassersdorf, Switzerland 

Document code Unit 

Instruction Manual 

Document Type 

HW4 software v.3 
HygroLog NT functions 

Document title 
Page 25 of 47 

 

© 2010; Rotronic AG                                                                                                           E-M-HW4v3-F1-001_10 

Time Schedule Tab:  
 

 
 
Use this tab to define when the relay is used to monitor the alarm conditions selected in the Energize 
Relay Tab. 
 
If you do not wish to use the relay to monitor alarm conditions 7 days a week and 24 hours a day, place a 
check mark next to “Use the following schedule” and define a time schedule. Both the start and stop time 
are common to all days of the week. 
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4  DATA LOGGING – with the HygroLog NT 
 

When HW4 has detected a HygroLog NT, the 
device appears in the left pane of the HW4 
main screen. Expanding the device displays a 
list of the available device functions. 
 
To select the Data Logging function, click on it 
with the left mouse button. HW4 opens the 
Data Logging form. 

 
 
The Data Logging form is used to set the date and time to start and stop logging data for each individual 
input of the HygroLog NT and docking station. Other settings such as the log interval and file management 
are also defined with this form. 
 
Clicking on the plus sign to the left of “Standard Inputs” or “Optional Inputs” expands the tree and displays a 
list of probe and logical inputs. Inputs are listed regardless of whether or not they do exist on the actual 
logger and docking station being used. Only those items selected in the View Tab are visible in Device 
Manager. When the list is either empty or incomplete, please exit Data Logging and check the selections 
made in the View Tab (see Right Pane: Device View Mode). To select an input, click on it with the left 
mouse button. 
 
Clicking on Standard Inputs, displays information on the memory card and battery at the bottom of the form. 
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Note: the Data Logging form is not used to define the type of log file (text or binary). The type of log file is 
common to all probes and inputs and is defined from within Device Manager / Memory Card. 

4.1   Menu Bar 
 
The menu bar is located at the top of the form. 
 
File 
 
● Exit: closes the Data Logging form without making any changes. 
 
Help 
 
● HW4 Help: Opens HW4 Help 
● About HW4: Displays the version number and ID number of HW4 
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4.2   Programming the HygroLog NT for data logging 
 
To program the HygroLog NT for logging data, select first an input with the mouse. 
 

 
 
● Start: enter the start date and the start time in each text box. To copy the current date and time from 
the PC, click on the “Right Now” blue link. 
 
● Stop: enter the stop date and the stop time in each text box. To copy the current date and time from the 
PC, click on the “Right Now” blue link. To stop logging immediately, click on this link, click on “Use 
these settings for all inputs” (only if you want to stop all other inputs) and click on the Send to 
Logger button. 
 
● Log interval: use the mouse to highlight any of the following: hours, minutes or seconds. Use the up or 
the down arrow to set the log interval to the desired value. 
 
● Start a new file: The “Start a new file” list box is used to tell the logger when to finish logging to the 
current file and when to start a new file. Click on the arrow located to the right of the list box to display a 
list of available options. The default setting is to close the file and start a new one after 200,000 data 
points but it is usually better to start a new file sooner (see NOTE below). 
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Every hour     : a new file is created at the top of each hour (local logger time) 
Every day      : a new file is created at 00:00 (midnight, local logger time) 
Every week : a new file is created at 00:00 on Mondays 
Every month  : a new file is created on the first day of each month at 00:00 
 
Note: the HygroLog NT creates a separate log file for each probe or input to be logged. 
 
NOTE: It is strongly recommended to limit the size of log files to the minimum allowed by your application. 
Unless necessary, do not use a very short log interval. As far as possible start a new file every day. 
Following these recommendations ensures that each file download from the data logger to the HW4 PC 
takes as little time as possible. 
 
● Description: use up to 32 characters to enter a description / identification for the log file. This will be 
part of the file header. 
 
● Log: check the box corresponding to each parameter to be logged (up to 3 parameters). In the case of 
an input with a single channel analog probe or with a pressure probe, you only need to check the top box. 
In the case of an RTD probe, you only need to check the Temperature box. In any case, no harm is done 
when the other boxes are also checked. 
 
Notes: 
 
● The selections made for one input can be transferred to all other inputs (except External Contacts) by 
clicking on “Use these settings for all inputs”. This includes the log file description. Alternatively, each 
probe or input can be individually programmed, using different settings. 
 
● When a digital HygroClip probe is connected to the input, the serial number of the probe is displayed at 
the bottom of the form. 
 
● When done, click with the mouse on the Send to Logger button. The HygroLog NT will start executing 
the log commands. 
 
● The HygroLog NT automatically gives each log file a name comprised of the last 4 digits of the logger 
serial number, followed by the input number and a sequential run number. 
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4.2.1 Recording the status of external contacts (logical inputs) 
 
Logical inputs are used to monitor the status of up to two external contacts, such as a door contact. 
 
The HygroLog NT records the status of the logical inputs in a different manner as used for other input 
types. Recording is not based on a log interval. When a check mark is placed in one or two of the 
“Contact” boxes, data logging is triggered automatically each time that a logical input changes its value 
from 0 to 1 or from 1 to 0, and holds the new value for 5 or more seconds. In the situation where a logical 
input has either the value 0 or the value 1 during the entire recording time, the log file does not record any 
data. 
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5  AUTOMATIC LOG FILE DOWNLOAD 
 

Note: this function is available only with HW4 Professional. 
 
The automatic log file download function is used to copy the log files present on the memory card of one or 
more HygroLog NT data loggers to a specific directory of the HW4 PC (including network drives). A different 
drive and/or directory can be assigned to each data logger. 
 
Depending on the selected interval, the function executes daily, weekly (Monday) or monthly (first day of the 
month) at 02:00 (2:00 am). The actual time may vary slightly, depending on factors such as network traffic, 
the number of data loggers and the number of files to be downloaded. The function can be configured to 
either delete the downloaded files from the logger memory card or to leave them on the memory card. The 
exact effects of the function depend both on the configuration of the function and on the programming of 
data logging on the data logger (see Example further down) 
 
IMPORTANT: File download operations take precedence over the automatic polling of devices. 
Consequently, the automatic polling of devices is suspended whenever a file download operation is in 
progress. It is good practice to ensure that each file download takes as little time as possible. To this 
purpose, the size of log files should be limited to the minimum allowed by your application. 
 

 
 

► Procedure: 
 

o Select the HygroLog NT in the device tree (left pane of the HW4 main screen). 
o Select the Log to PC tab in the right pane of the HW4 main screen. The automatic log file function 

can be enabled and configured using the controls located at the bottom of the Log to PC tab 
o Click with the mouse on the arrow located to the right of the box labeled Download Interval 

and select one of the available options from the drop down menu. 
o Select a path where to download the files (click on the button to the right of the path field to 

display drives and folders) 
o Enable or disable the file automatic deletion from the logger memory card 
o Define a file name structure (3 fields are available for this). The file type is the same as on the 

logger (file extension XLS or LOG) 
o Click on the “Start” button 
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HW4 confirms that the function is enabled: 
 

 
 
After each file download, HW4 refreshes the Last Download and Next Download fields: 
 
To disable the function, click with the mouse on the End button. The screen reverts to its default 

5.1   Examples 
 
The following examples illustrate which results to expect from the automatic log file download function 
under different circumstances. All times are in the 24 hour format. 
 
Notes: 
 
• When a file is deleted from the logger memory card while logging is active, the HygroLog NT 

automatically recreates the file under the same name as soon as it writes the next data point. The 
data that was present before deletion is no longer part of the file. 

 
• New files started by the data logger (configuration of the data logging function): 

 
Every hour     : a new file is created at the top of each hour (local logger time) 
Every day      : a new file is created at 00:00 (midnight, local logger time) 
Every week : a new file is created at 00:00 on Mondays 
Every month  : a new file is created on the first day of each month at 00:00 

 
• HW4 will not copy twice the exact same file to the PC 
 
Example 1 
 
• Logger settings for input 1: 
 
Start time  : 06/19/10 11:39 
End time  : 06/22/10 11:39 
Log interval  : 10 minutes 
Start a new file : Every day 
 
• Automatic download function settings: 
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Download interval : Daily 
Downloaded files : Delete from logger memory card 
 
• Situation on 06/23/10 after completing the last automatic download: 
 
Number of files generated by the data logger: 4 
 
Number of files present on the data logger memory card: 0 
 
Number of files present on the HW4 PC: 7 
 
File 1: 06/19/10 11:39 to 06/19/10 23:59 
File 2: 06/20/10 00:09 to 06/20/10 01:59 
File 3: 06/20/60 02:09 to 06/20/10 23:59 
File 4: 06/21/10 00:09 to 06/21/10 01:59 
File 5: 06/21/10 02:09 to 06/21/10 23:59 
File 6: 06/22/10 00:09 to 06/22/10 01:59 
File 7: 06/22/10 02:09 to 06/22/10 11:39 
 
Notes 
 
File 1 is the same as the original logger file 
Files 2 and 3 correspond to an original logger file split in two, etc.  
 
Example 2 
 
• Logger settings for input 1: 
 
Start time  : 06/20/10 10:12 
End time  : 06/23/10 11:39 (stopped manually) 
Log interval  : 5 minutes 
Start a new file : Every day 
 
• Automatic download function settings: 
 
Download interval : Daily 
Downloaded files : Keep on memory card after downloading 
 
• Situation on 06/23/10 after completing the last automatic download: 
 
Number of files generated by the data logger: 4 
 
Number of files present on the data logger memory card: 4 
 
File 1: 06/20/10 10:12 to 06/20/10 23:57 
File 2: 06/21/10 00:02 to 06/21/10 23:57 
File 3: 06/22/10 00:02 to 06/22/10 23:57 
File 4: 06/23/10 00:02 to 06/23/10 11:39 
 
Number of files present on the HW4 PC: 7 
 
File 1: 06/20/10 10:12 to 06/20/10 23:57 
File 2: 06/21/10 00:02 to 06/21/10 01:57 
File 3: 06/21/10 00:02 to 06/21/10 23:57 
File 4: 06/22/10 00:02 to 06/22/10 01:57 
File 5: 06/22/10 00:02 to 06/22/10 23:57 
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File 6: 06/23/10 00:02 to 06/22/10 01:57 
File 7: 06/23/10 00:02 to 06/23/10 11:37 
 
Notes 
 
File 1 is the same as the original logger file 
Files 2 and 3 correspond to file 2 on the logger memory card, split in two, etc.  
 
Example 3 
 
• Logger settings for input 1: 
 
Start time  : 06/20/10 10:12 
End time  : 06/23/10 11:39 (stopped manually) 
Log interval  : 5 minutes 
Start a new file : Every week 
 
• Automatic download function settings: 
 
Download interval : Daily 
Downloaded files : Keep on memory card after downloading 
 
• Situation on 06/23/10 after completing the last automatic download: 
 
Number of files generated by the data logger: 1 
 
Number of files present on the data logger memory card: 1 
 
File 1: 06/20/10 10:12 to 06/23/10 11:37 
 
Number of files present on the HW4 PC: 5 
 
File 1: 06/20/10 10:12 to 06/20/10 01:58 
File 2: 06/20/10 10:12 to 06/21/10 01:58 
File 3: 06/20/10 10:12 to 06/22/10 01:58 
File 4: 06/20/10 10:12 to 06/23/10 01:58 
File 5: 06/20/10 10:12 to 06/23/10 11:37 
 
Notes 
 
File 1 (data logger) grows larger every day 
Files 1 to 5 (PC) these files contain ever increasing amounts of duplicated data.  
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6  ACCESS DATA 
 

When HW4 has discovered a HygroLog NT, 
the device appears in the left pane of the HW4 
main screen. Expanding the device displays a 
list of the available device functions. 
 
To select the Access Data function, click on it 
with the left mouse button. HW4 opens the 
HW4 Explorer form. 

 
 

6.1   HW4 Explorer 
 

 
 
● Left Pane: the left pane of the HW4 Explorer form provides a list of the files currently present in the 
memory card of the HygroLog NT. Select the Log file tab to view log files. Select the Events and system 
data tab to view the logger event file (extension .EVT) and the logger configuration file (extension .DAT). 
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Log files 
 

 
 
Logger event and logger configuration files 
 

 
 
A file with the extension .EVT and one with the extension .DAT are always present in the memory card. 
These files cannot be deleted with HW4. 
 
● Right pane: the right pane of the HW4 Explorer form provides a list of the log files, protocols, event files 
and configuration files currently present on the PC. The location of these files depends on the directory 
that was specified for each type of file in HW4 Global Settings / File Locations. 
 

 
 
Any file present in the memory card can be opened, copied or moved to the computer, or deleted from the 
memory card. The logger event and logger configuration files are also present in the internal EEPROM of 
the HygroLog NT. If not present, these two files will be automatically written to the memory card by the 
logger. Files that are on the computer can be either opened or deleted. These files cannot be copied or 
moved to the memory card. 
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6.2   Menu Bar 
The menu bar is located at the top of the HW4 Explorer form. 
 
File 
 
• Open: opens any file that is highlighted either in the left pane of the Explorer (memory card) or in the 

right pane (computer). 
 
Note: files located on the logger memory card are automatically copied to the PC before being 
opened. 

 
• Exit: exits the HW4 Explorer 
 
File Operations 
 
Note: highlight the file first. 
 
• Move: copies the file from the memory card to the computer and deletes the file from the memory 

card (except for event and configuration files). 
 
• Copy: copies the file from the memory card to the computer and leaves the file in the memory card. 
 
• Delete: deletes the file from the memory card or from the computer (except for event and 

configuration files located on the memory card). Several files may be selected at the same time for 
deletion. 

 
Note: these functions are also directly available by right clicking with the mouse on the file. 
 
IMPORTANT: File download operations take precedence over the automatic polling of devices. 
Consequently, the automatic polling of devices is suspended during the time that it takes for a file to be 
copied from the data logger to the HW4 PC. It is good practice to ensure that each file download takes as 
little time as possible. To this purpose, the size of log files should be limited to the minimum allowed by 
your application. 
 
Help 
 
The Help menu consists of: 
 
• HW4 Help: Opens HW4 Help 
 
• About HW4: Displays the version number and ID number of HW4 
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6.3   Files located on the PC 
 
In the right pane of HW4 Explorer, highlight the appropriate folder in C:\Documents and Settings\your 
Windows login name\ROTRONIC_HW4: 
 
• DATA: this folder holds the log files that have been copied or transferred (moved) from the data 

logger to the PC. 
 
• DATA_ONLINE: this folder holds the log files directly created on the PC (Log to PC). 
 
• DOC: this folder holds protocol files (logger configuration, logger programming and probe 

adjustment). 
 
• EVENT: this folder holds user event files as well as HW4 event files (used for troubleshooting 

software problems). 
 
• SYS: this folder can be used to hold frequently used instrument configuration files for future use from 

within Device Manager 
 

 
 
 
Highlight one of the files present in the folder. To open or delete the file, click on File Operations in the 
HW4 explorer menu bar or right click on the file to open a small menu next to the file name. 
 



E-M-HW4v3-F1-001_10 Rotronic AG 
Bassersdorf, Switzerland 

Document code Unit 

Instruction Manual 

Document Type 

HW4 software v.3 
HygroLog NT functions 

Document title 
Page 39 of 47 

 

© 2010; Rotronic AG                                                                                                           E-M-HW4v3-F1-001_10 

6.4   Files located on the logger 
 
● Event and Configuration files 
 
In the left pane of HW4 Explorer, select the Events and Configuration Files tab and right click on any file. 
This opens a small menu box next to the file name. Select with the mouse the desired file operation. 
 
Example of a logger event file (file extension .EVT) 
 

 
 
The HygroLog NT keeps internally track of the last 170 operations, events and configuration changes in 
its internal EEPROM memory as well as in the .EVT file located on the memory card. 
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Example of a logger configuration file (file extension .DAT) 
 
The contents of a logger configuration files are displayed using the Device Manager (for details, see 
Device Manager). 
 

 
 
● Log files 
 
In the left pane of HW4 Explorer, select the Log Files tab and right click on the file. This opens a small 
menu box next to the file. Click with the mouse on Open. HW4 first downloads the file and makes a copy 
on the PC. 
 

6.5   Opening a log file in View Data 
 
A log file can be opened in View Data from the HW4 Explorer. 
 
In HW4 Explorer, select either a log file located on the HygroLog NT (left pane - Log Files tab) or a log file 
located on the PC (right pane – DATA or DATA_ONLINE folder). Use the HW4 Explorer file menu to open 
the file. As an alternative right click with the mouse on the file and select “Open” from the small file menu. 
 
When the file is located on the HygroLog NT, HW4 begins by making a copy of the file to the PC, prior to 
opening the file in View Data: 
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After copying the file to the PC, HW4 opens the file in View Data. When the file is already located on the 
PC, HW4 immediately opens the file in View Data: 
 

 
 
For more information on HW4 View Data see View / Sign a Log File in document E-IN-HW4v2.1-Main  
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7  ERES REGULATORY COMPLIANCE (HW4 
Professional) 

7.1   Required settings and selections 
The following settings and selections are required in order to comply with FDA / GAMP regulatory 
requirements regarding electronic records, electronic signatures (ERES) and the tracking of software 
problems. 
 
● Main Screen Menu Bar – Users and Passwords: create at least one user with administrative rights. 
 
● HW4 Global Settings – General Tab: Enable system monitoring (tracking of software problems) 
 
● HW4 Global Settings – Events Tab: Enable authentication stamps and enable the monitoring of user 
events. 
 
● HW4 Global Settings – Events Tab: enable protocols (see Record keeping by HW4) 
 
● Device Manager – User Information Form: put a check mark in the box labeled “include in log file” 
 
● Device Manager – Keypad Form: disable the MENU key of the HygroLog NT to prevent unauthorized 
or undocumented operations. 
 
● Log file type: select the file extension LOG for the log files (measurement data) recorded either with 
HW4 on the PC or with the HygroLog NT. For the HygroLog NT, the file type is selected from Device 
Manager – Memory Card. For the files recorded by HW4 to the PC, the selection is done in the Log to PC 
tab on the Main Screen at the time the file name is entered. 

 

7.2   Electronic records 
In compliance with regulatory requirements regarding electronic records, electronic signatures (ERES) and 
the tracking of software problems, HW4 maintains a number of event files and protocols. To effectively 
comply with ERES regulatory requirements, both types of record must be enabled in HW4 Global Settings. 
Details on the event file maintained by the HygroLog NT are provided in the “Internal Record keeping” 
section of this manual. 
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7.3   Log File Format 
Both HW4 (direct data logging to the PC) and the HygroLog NT offer the choice of two different types of 
file format to record the measured data. Both file types have two main sections: the file header and the 
measurement data. 
 
● Binary Files (LOG): the header section of this type of file can be read with a regular text editor. As 
opposed to this, the data section is in binary format and cannot be read with a text editor or imported into 
a program such as Microsoft Excel. Both the header and data sections are protected against alterations. 
If the file contents are somehow modified, HW4 will display an error message when trying to open the file. 
 
For maximum protection of the recorded data and to comply with ERES regulatory requirements, 
use the LOG file type. 
 
● Text Files (XLS): these files are entirely in text format and can be read with a regular text editor. This 
type of file is easily imported into Microsoft Excel. Like all the other files created by HW4, files with the 
XLS extension are saved with the “Read Only” attribute. This attribute provides a protection against 
inadvertent file operations such as file delete, file move and saving the file under the same name and 
location (eventually after altering the file contents). Since it is possible to remove the “Read Only” 
attribute, this attribute does not provide protection against intentional alterations. HW4 does not detect 
alterations to a file with the XLS extension. 
 
As an additional protection, HW4 keeps track of the date and time when a log file is created or copied to 
the PC. This information is kept in the protected user event file and can be compared with the file creation 
/ file modification date and time recorded by Windows. 
 
Note: the HygroLog NT automatically gives each log file a name comprised of the last 4 digits of the 
logger serial number, followed by the input number and a sequential run number. 
 

8  INTERNAL RECORD KEEPING – HygroLog NT 
 
The HygroLog NT maintains an internal event file with the extension EVT. No particular configuration is 
required to enable this feature. 
 
Part of the procedure to ensure conformity to ERES regulatory requirements is to disable the MENU key 
on the HygroLog NT keypad. The MENU key is the only one that can be used to make changes to the 
logger. Therefore, the events recorded by the HygroLog NT are normally the result of an interaction with 
the HW4 software. When the MENU key is not disabled, a limited number of events are recorded in the 
logger event file and no entries are made in the logger event file header. The two tables below provide a 
list of the events tracked by the HygroLog NT. 
 
The logger event file is split between the internal memory of the logger (up to 170 events) and the flash 
memory card (practically unlimited number of events). HW4 offers the possibility of downloading, opening 
and printing the entire file contents (use the Access Data function). All past logger events are available to 
HW4 as long as the flash memory card is not removed from the logger. The serial number of the logger is 
used as the file name. 
 
Example: 1111111111.EVT 
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The logger event file consists of a file header and a file body. The file header provides the following 
information: 
 
- Most recent programming of the log function: programming date and time, user and HW4 product ID 
- Most recent device configuration: date and time, user and HW4 product ID 
- Most recent adjustment to the PC date and time: date and time, user and HW4 product ID 
 
An individual record with date and time is entered in the event file body for each event listed in the table 
below: 
 

Event File Text Event (interaction with HW4) 

Power up The battery was inserted or the instrument powered down and up after an 
internal problem 

Watchdog overflow Internal instrument error (normally should not occur) 

Writing device 
configuration New or existing configuration written to logger 

Memory card removed While recording data, the logger could not find the memory card. The data 
was written to the EEPROM and are not yet lost 

Memory card full No free memory space on the memory card 

New memory card 
inserted 

The memory card was replaced while data was being logged. The data will 
be split between two different memory cards. Possibly, some data has been 
lost. 

Humidity adjusted Humidity adjustment of the probe connected to input # 

Temperature adjusted Temperature adjustment of the probe connected to input # 

Logging started Start recording data from input # 

Logging stopped 
manually Data recording of input # ended before the programmed stop time 

Logging ended 
automatically Data recording of input # ended at the programmed stop time 

Out-of-limits value 
detected An out-of-limits value was newly detected on input # 

Battery almost empty Battery voltage dropped below  6.5V 

Battery empty The battery is empty and the logger has powered itself off (keeping power 
up could result in erroneous data or loss of data) 

Beginning accumulator 
charge Starting to charge the rechargeable battery 
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Event File Text Event (interaction with HW4) 

Accumulator charge 
ended Rechargeable battery full 

MFG command Reserved for the factory 

Lost data, memory card 
not ready 

While recording data, the logger could not find the memory card. The data 
could not be written to the EEPROM, and was lost 

HygroClip probe 
connected 1 A HygroClip probe was connected to input # 

HygroClip probe 
disconnected 1

A HygroClip probe was removed from input # or the input can no longer 
communicate with the probe 

External power 
connected The A/C adapter was connected and is being powered 

External power 
removed or faulty The A/C adapter was disconnected, or failed, or is not being powered 

Device time changed / 
adjusted Device date and time prior and after adjustment (up to firmware v1.1d only) 

Prior device time Device date and time prior to change (firmware v1.2a and up) 

New device time Device date and time after change (firmware v1.2a and up) 

RS-485 address 
changed The RS-485 address was changed 

EEPROM erased Reserved for the factory 

Docking station 
disconnected 2

The docking station was disconnected or there is no longer any 
communication with it 

Docking station 
connected 2 A docking station was connected and communication was established 

Logger language file 
downloaded 

A different internal language file was loaded or the same file was loaded 
again 

Log function 
programmed The log function has been programmed for input # 

Event file deleted Reserved for the factory 
 

1 connection / removal of analog probes is not recorded 
2 only when the docking station has internal electronics 
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Event File Text Event (triggered from the Keypad) 

Humidity adjusted Humidity adjustment of the probe connected to input # 

Temperature adjusted Temperature adjustment of the probe connected to input # 

Logging started Start recording data from input # 

Logging stopped 
manually Data recording of input # ended before the programmed stop time 

Prior device time Device date and time prior to change (firmware v1.2a and up) 

New device time Device date and time after change (firmware v1.2a and up) 

Log function 
programmed The log function has been programmed for input # 

 

9  DOCUMENT RELEASES 
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